
Chapter 5: Modeling External Compressible Flow

This tutorial is divided into the following sections:
5.1. Introduction
5.2. Prerequisites
5.3. Problem Description
5.4. Setup and Solution
5.5. Summary
5.6. Further Improvements

5.1. Introduction

The purpose of this tutorial is to compute the turbulent flow past a transonic airfoil at a nonzero angle
of attack. You will use the Spalart-Allmaras turbulence model.

This tutorial demonstrates how to do the following:

• Model compressible flow (using the ideal gas law for density).

• Set boundary conditions for external aerodynamics.

• Use the Spalart-Allmaras turbulence model.

• Use Full Multigrid (FMG) initialization to obtain better initial field values.

• Calculate a solution using the pressure-based coupled solver with the pseudo transient option.

• Use force and surface monitors to check solution convergence.

• Check the near-wall mesh resolution by plotting the distribution of 
+

.

5.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing
Elbow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in
the setup and solution procedure will not be shown explicitly.
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5.3. Problem Description

The problem considers the flow around an airfoil at an angle of attack 
!=  and a free stream Mach

number of  ( =∞ ). The flow is transonic, and has a fairly strong shock near the mid-chord

( = ) on the upper (suction) side. The chord length is 1 m. The geometry of the airfoil is shown
in Figure 5.1: Problem Specification (p. 222).

Figure 5.1:  Problem Specification

5.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
5.4.1. Preparation
5.4.2. Mesh
5.4.3. General Settings
5.4.4. Models
5.4.5. Materials
5.4.6. Boundary Conditions
5.4.7. Operating Conditions
5.4.8. Solution
5.4.9. Postprocessing

5.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 15.0 under Version.

5. Select this tutorial from the list.
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6. Click Files to download the input and solution files.

7. Unzip external_compressible_R150.zip to your working folder.

The file airfoil.msh can be found in the external_compressible folder created after unzipping
the file.

8. Use Fluent Launcher to start the 2D version of ANSYS Fluent.

Fluent Launcher displays your Display Options preferences from the previous session.

For more information about Fluent Launcher, see Starting ANSYS Fluent Using Fluent Launcher in
the User’s Guide.

9. Ensure that the Display Mesh After Reading, Embed Graphics Windows, and Workbench Color
Scheme options are enabled.

10. Enable Double Precision.

11. Ensure Serial is selected under Processing Options.

5.4.2. Mesh

1. Read the mesh file airfoil.msh.

File → Read → Mesh...

2. Check the mesh.

General → Check

ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Make
sure that the reported minimum volume is a positive number.

Note

ANSYS Fluent will issue a warning concerning the high aspect ratios of some cells
and possible impacts on calculation of Cell Wall Distance. The warning message in-
cludes recommendations for verifying and correcting the Cell Wall Distance calcula-
tion. In this particular case the cell aspect ratio does not cause problems so no further
action is required. As an optional activity, you can confirm this yourself after the
solution is generated by plotting Cell Wall Distance as noted in the warning message.

3. Examine the mesh (Figure 5.2: The Entire Mesh (p. 224) and Figure 5.3: Magnified View of the Mesh Around
the Airfoil (p. 225)).
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Figure 5.2: The Entire Mesh

Quadrilateral cells were used for this simple geometry because they can be stretched easily to account
for different flow gradients in different directions. In the present case, the gradients normal to the airfoil
wall are much greater than those tangent to the airfoil. Consequently, the cells near the surface have
high aspect ratios. For geometries that are more difficult to mesh, it may be easier to create a hybrid
mesh comprised of quadrilateral and triangular cells.
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Figure 5.3:  Magnified View of the Mesh Around the Airfoil

A parabola was chosen to represent the far-field boundary because it has no discontinuities in slope,
enabling the construction of a smooth mesh in the interior of the domain.

Extra

You can use the right mouse button to probe for mesh information in the graphics win-
dow. If you click the right mouse button on any node in the mesh, information will be
displayed in the ANSYS Fluent console about the associated zone, including the name of
the zone. This feature is especially useful when you have several zones of the same type
and you want to distinguish between them quickly.

4. Reorder the mesh.

Mesh → Reorder → Domain
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This is done to reduce the bandwidth of the cell neighbor number and to speed up the computations.
This is especially important for large cases involving 1 million or more cells. The method used to reorder
the domain is the Reverse Cuthill-McKee method.

5.4.3. General Settings

1. Set the solver settings.

a. Retain the default selection of Pressure-Based from the Type list.

The pressure-based solver with the Coupled option for the pressure-velocity coupling is a good altern-
ative to density-based solvers of ANSYS Fluent when dealing with applications involving high-speed
aerodynamics with shocks. Selection of the coupled algorithm is made in the Solution Methods task
page in the Solution step.

5.4.4. Models

1. Select the Spalart-Allmaras turbulence model.

Models → Viscous → Edit...
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a. Select Spalart-Allmaras (1eqn) in the Model list.

b. Select Strain/Vorticity-Based in the Spalart-Allmaras Production list.

c. Retain the default settings in the Model Constants group box.

d. Click OK to close the Viscous Model dialog box.

Note

The Spalart-Allmaras model is a relatively simple one-equation model that solves a modeled
transport equation for the kinematic eddy (turbulent) viscosity. This embodies a relatively
new class of one-equation models in which it is not necessary to calculate a length scale
related to the local shear layer thickness. The Spalart-Allmaras model was designed spe-
cifically for aerospace applications involving wall-bounded flows and has been shown to
give good results for boundary layers subjected to adverse pressure gradients.

5.4.5. Materials

The default Fluid Material is air, which is the working fluid in this problem. The default settings need to be
modified to account for compressibility and variations of the thermophysical properties with temperature.

1. Set the properties for air, the default fluid material.

Materials → air → Create/Edit...
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a. Select ideal-gas from the Density drop-down list.

The Energy Equation will be enabled.

b. Select sutherland from the Viscosity drop-down list to open the Sutherland Law dialog box.

Scroll down the Viscosity drop-down list to find sutherland.

i. Retain the default selection of Three Coefficient Method in the Methods list.

ii. Click OK to close the Sutherland Law dialog box.

The Sutherland law for viscosity is well suited for high-speed compressible flows.
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c. Click Change/Create to save these settings.

d. Close the Create/Edit Materials dialog box.

While Density and Viscosity have been made temperature-dependent, Cp (Specific Heat) and Thermal
Conductivity have been left constant. For high-speed compressible flows, thermal dependency of the
physical properties is generally recommended. For simplicity, Thermal Conductivity and Cp (Specific
Heat) are assumed to be constant in this tutorial.

5.4.6. Boundary Conditions

Boundary Conditions

1. Set the boundary conditions for pressure-far-field-1.

Boundary Conditions → pressure-far-field-1 → Edit...
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a. Retain the default value of 0 Pa for Gauge Pressure.

Note

The gauge pressure in ANSYS Fluent is always relative to the operating pressure, which
is defined in a separate input (see below).

b. Enter 0.8 for Mach Number.

c. Enter 0.997564 and 0.069756 for the X-Component of Flow Direction and Y-Component of
Flow Direction, respectively.

These values are determined by the 
!

 angle of attack:
! ≈  and 

! ≈ .

d. Retain Turbulent Viscosity Ratio from the Specification Method drop-down list in the Turbulence
group box.

e. Retain the default value of 10 for Turbulent Viscosity Ratio.

The viscosity ratio should be between 1 and 10 for external flows.

f. Click the Thermal tab and retain the default value of 300 K for Temperature.
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g. Click OK to close the Pressure Far-Field dialog box.

5.4.7. Operating Conditions

1. Set the operating pressure.

Boundary Conditions → Operating Conditions...

The Operating Conditions dialog box can also be accessed from the Cell Zone Conditions task page.

a. Retain the default value of 101325 Pa for Operating Pressure.
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The operating pressure should be set to a meaningful mean value in order to avoid round-off errors.
The absolute pressure must be greater than zero for compressible flows. If you want to specify
boundary conditions in terms of absolute pressure, you can make the operating pressure zero.

b. Click OK to close the Operating Conditions dialog box.

For information about setting the operating pressure, see Operating Pressure in the User's Guide.

5.4.8. Solution

1. Set the solution parameters.

Solution Methods

a. Select Coupled from the Scheme drop-down list in the Pressure-Velocity Coupling group box.

b. Retain the default selection of Least Squares Cell Based from the Gradient drop-down list in the
Spatial Discretization group box.

c. Retain the default selection of Second Order from the Pressure drop-down list.

d. Select Second Order Upwind from the Modified Turbulent Viscosity drop-down list.

e. Enable Pseudo Transient.
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The Pseudo Transient option enables the pseudo transient algorithm in the coupled pressure-based
solver. This algorithm effectively adds an unsteady term to the solution equations in order to improve
stability and convergence behavior. Use of this option is recommended for general fluid flow problems.

2. Set the solution controls.

Solution Controls

a. Enter 0.5 for Density in the Pseudo Transient Explicit Relaxation Factors group box.

Under-relaxing the density factor is recommended for high-speed compressible flows.

b. Enter 0.9 for Modified Turbulent Viscosity.

Larger under-relaxation factors (that is, closer to 1) will generally result in faster convergence. However,
instability can arise that may need to be eliminated by decreasing the under-relaxation factors.

3. Enable residual plotting during the calculation.

Monitors → Residuals → Edit...
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a. Ensure that Plot is enabled in the Options group box and click OK to close the Residual Monitors
dialog box.

4. Initialize the solution.

Solution Initialization

a. Retain the default selection of Hybrid Initialization from the Initialization Methods group box.

b. Click Initialize to initialize the solution.

c. Run the Full Multigrid (FMG) initialization.

FMG initialization often facilitates an easier start-up, where no CFL (Courant Friedrichs Lewy) ramping
is necessary, thereby reducing the number of iterations for convergence.

i. Press Enter in the console to get the command prompt (>).
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ii. Enter the text commands and input responses as shown in the boxes. Accept the default values
by pressing Enter when no input response is given:

solve/initialize/set-fmg-initialization

 Customize your FMG initialization:
   set the number of multigrid levels [5]

   set FMG parameters on levels ..

    residual reduction on level 1 is:  [0.001]
    number of cycles on level 1 is:  [10]  100

    residual reduction on level 2 is:  [0.001]
    number of cycles on level 2 is:  [50]  100

    residual reduction on level 3 is:  [0.001]
    number of cycles on level 3 is:  [100]

    residual reduction on level 4 is:  [0.001]
    number of cycles on level 4 is:  [500]

    residual reduction on level 5 [coarsest grid] is:  [0.001]
    number of cycles on level 5 is:  [500]

  Number of FMG (and FAS  geometric multigrid) levels: 5
 * FMG customization summary:
 *   residual reduction on level 0 [finest grid] is: 0.001
 *   number of cycles on level 0 is: 1
 *   residual reduction on level 1 is: 0.001
 *   number of cycles on level 1 is: 100
 *   residual reduction on level 2 is: 0.001
 *   number of cycles on level 2 is: 100
 *   residual reduction on level 3 is: 0.001
 *   number of cycles on level 3 is: 100
 *   residual reduction on level 4 is: 0.001
 *   number of cycles on level 4 is: 500 
 *   residual reduction on level 5 [coarsest grid] is: 0.001
 *   number of cycles on level 5 is: 500
 * FMG customization complete

   set FMG courant-number [0.75]

   enable FMG verbose? [no] yes

solve/initialize/fmg-initialization
Enable FMG initialization? [no] yes

Note

Whenever FMG initialization is performed, it is important to inspect the FMG initialized
flow field using the postprocessing tools of ANSYS Fluent. Monitoring the normalized
residuals, which are plotted in the console window, will give you an idea of the conver-
gence of the FMG solver. You should notice that the value of the normalized residuals
decreases. For information about FMG initialization, including convergence strategies,
see Full Multigrid (FMG) Initialization in the User’s Guide.

5. Save the case and data files (airfoil.cas.gz and airfoil.dat.gz).

File → Write → Case & Data...

It is good practice to save the case and data files during several stages of your case setup.
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6. Start the calculation by requesting 50 iterations.

Run Calculation

a. Enter 50 for Number of Iterations.

b. Click Calculate.

By performing some iterations before setting up the force monitors, you will avoid large initial transients
in the monitor plots. This will reduce the axes range and make it easier to judge the convergence.

7. Set the reference values that are used to compute the lift, drag, and moment coefficients.

Reference Values

The reference values are used to nondimensionalize the forces and moments acting on the airfoil. The
dimensionless forces and moments are the lift, drag, and moment coefficients.

a. Select pressure-far-field-1 from the Compute from drop-down list.

ANSYS Fluent will update the Reference Values based on the boundary conditions at the far-field
boundary.
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8. Define a force monitor to plot and write the drag coefficient for the walls of the airfoil.

Monitors (Residuals, Stastistic and Force Monitors) → Create → Drag...

a. Enable Plot in the Options group box.

b. Enable Write to save the monitor history to a file.

Note

If you do not enable the Write option, the history information will be lost when you
exit ANSYS Fluent.

c. Retain the default entry of cd-1-history for File Name.

d. Select wall-bottom and wall-top in the Wall Zones selection list.

e. Enter 0.9976 for X and 0.06976 for Y in the Force Vector group box.

These X and Y values ensure that the drag coefficient is calculated parallel to the free-stream flow,

which is 
!

 off of the global coordinates.

f. Click OK to close the Drag Monitor dialog box.
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9. Similarly, define a force monitor for the lift coefficient.

Monitors → Create → Lift...

Enter the values for X and Y shown in the Lift Monitor dialog box.

The X and Y values shown ensure that the lift coefficient is calculated normal to the free-stream flow,

which is 
!

 off of the global coordinates.

10. In a similar manner, define a force monitor for the moment coefficient.

Monitors → Create → Moment...
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Enter the values for the Moment Center and Moment Axis shown in the Moment Monitor dialog
box.

11. Display filled contours of pressure overlaid with the mesh in preparation for defining a surface monitor
(Figure 5.4: Pressure Contours After 50 Iterations (p. 241) and Figure 5.5: Magnified View of Pressure Contours
Showing Wall-Adjacent Cells (p. 242)).

Graphics and Animations → Contours → Set Up...
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a. Enable Filled in the Options group box.

b. Enable Draw Mesh to open the Mesh Display dialog box.

i. Retain the default settings.

ii. Close the Mesh Display dialog box.

c. Click Display and close the Contours dialog box.
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Figure 5.4:  Pressure Contours After 50 Iterations

The shock is clearly visible on the upper surface of the airfoil, where the pressure jumps to a higher
value downstream of the low pressure area.

Note

The color indicating a high pressure area near the leading edge of the airfoil is ob-
scured by the overlaid green mesh. To view this contour, simply disable the Draw
Mesh option in the Contours dialog box and click Display.

d. Zoom in on the shock wave, until individual cells adjacent to the upper surface (wall-top boundary)
are visible, as shown in Figure 5.5: Magnified View of Pressure Contours Showing Wall-Adjacent
Cells (p. 242).
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Figure 5.5:  Magnified View of Pressure Contours Showing Wall-Adjacent Cells

The magnified region contains cells that are just downstream of the shock and adjacent to the upper
surface of the airfoil. In the following step, you will create a point surface inside a wall-adjacent cell,
which you will use to define a surface monitor.

12. Create a point surface just downstream of the shock wave.

Surface → Point...
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a. Enter 0.53 m for x0 and 0.051 m for y0 in the Coordinates group box.

b. Retain the default entry of point-4 for New Surface Name.

c. Click Create and close the Point Surface dialog box.

Note

You have entered the exact coordinates of the point surface so that your convergence
history will match the plots and description in this tutorial. In general, however, you will
not know the exact coordinates in advance, so you will need to select the desired location
in the graphics window. You do not have to apply the following instructions at this point
in the tutorial; they are added here for your information:

a. In the Point Surface dialog box, click the Select Point with Mouse button. A Working
dialog box will open telling you to “Click on a location in the graphics window with the
MOUSE-PROBE mouse button.”

b. Position the mouse pointer at a point located inside one of the cells adjacent to the upper
surface (wall-top boundary), downstream of the shock (see Figure 5.6: Pressure Contours
after Creating a Point with the Mouse (p. 244)).

c. Click the right mouse button.

d. Click Create to create the point surface and then close the Point Surface dialog box.
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Figure 5.6:  Pressure Contours after Creating a Point with the Mouse

13. Enable residual plotting during the calculation.

Monitors → Residuals → Edit...
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a. Ensure that Plot is enabled in the Options group box.

b. Select none from the Convergence Criterion drop-down list so that automatic convergence checking
does not occur.

c. Click OK to close the Residual Monitors dialog box.

14. Define a surface monitor for tracking the velocity magnitude value at the point created in the previous
step.

Since the drag, lift, and moment coefficients are global variables, indicating certain overall conditions,
they may converge while local conditions at specific points are still varying from one iteration to the
next. To account for this, define a monitor at a point (just downstream of the shock) where there is likely
to be significant variation, and monitor the value of the velocity magnitude.

Monitors (Surface Monitors) → Create...
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a. Enable Plot and Write.

b. Select Vertex Average from the Report Type drop-down list.

Scroll down the Report Type drop-down list to find Vertex Average.

c. Select Velocity... and Velocity Magnitude from the Field Variable drop-down list.

d. Select point-4 in the Surfaces selection list.

e. Click OK to close the Surface Monitor dialog box.

15. Save the case and data files (airfoil-1.cas.gz and airfoil-1.dat.gz).

File → Write → Case & Data...

16. Continue the calculation for 200 more iterations.

Run Calculation

The force monitors (Figure 5.8: Drag Coefficient Convergence History (p. 247) and Figure 5.9: Lift Coefficient
Convergence History (p. 248)) show that the case is converged after approximately 200 iterations.
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Figure 5.7: Velocity Magnitude History

Figure 5.8:  Drag Coefficient Convergence History
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Figure 5.9:  Lift Coefficient Convergence History

Figure 5.10:  Moment Coefficient Convergence History

17. Save the case and data files (airfoil-2.cas.gz and airfoil-2.dat.gz).

File → Write → Case & Data...
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5.4.9. Postprocessing

1. Plot the 
+

 distribution on the airfoil (Figure 5.11: XY Plot of y+ Distribution (p. 250)).

Plots → XY Plot → Set Up...

a. Disable Node Values in the Options group box.

b. Select Turbulence... and Wall Yplus from the Y Axis Function drop-down list.

Wall Yplus is available only for cell values.

c. Select wall-bottom and wall-top in the Surfaces selection list.

d. Click Plot and close the Solution XY Plot dialog box.

Note

The values of 
+

 are dependent on the resolution of the mesh and the Reynolds number

of the flow, and are defined only in wall-adjacent cells. The value of 
+

 in the wall-adjacent

cells dictates how wall shear stress is calculated. When you use the Spalart-Allmaras

model, you should check that 
+

 of the wall-adjacent cells is either very small (on the

order of =+ ), or approximately 30 or greater. Otherwise, you should modify your mesh.

The equation for 
+

 is

(5.1)=+
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where  is the distance from the wall to the cell center,  is the molecular viscosity,  is

the density of the air, and  is the wall shear stress.

Figure 5.11: XY Plot of y+ Distribution (p. 250) indicates that, except for a few small regions

(notably at the shock and the trailing edge), >+  and for much of these regions it

does not drop significantly below 30. Therefore, you can conclude that the near-wall
mesh resolution is acceptable.

Figure 5.11:  XY Plot of y+ Distribution

2. Display filled contours of Mach number (Figure 5.12: Contour Plot of Mach Number (p. 251)).

Graphics and Animations → Contours → Set Up...

a. Ensure Filled is enabled in the Options group box.

b. Select Velocity... and Mach Number from the Contours of drop-down list.

c. Click Display and close the Contours dialog box.

d. Zoom in on the region around the airfoil, as shown in Figure 5.12: Contour Plot of Mach Number (p. 251).
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Figure 5.12:  Contour Plot of Mach Number

Note the discontinuity, in this case a shock, on the upper surface of the airfoil in Figure 5.12: Contour

Plot of Mach Number (p. 251) at about ≈ .

3. Plot the pressure distribution on the airfoil (Figure 5.13: XY Plot of Pressure (p. 252)).

Plots → XY Plot → Set Up...

a. Enable Node Values.

b. Select Pressure... and Pressure Coefficient from the Y Axis Function drop-down lists.

c. Click Plot.
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Figure 5.13:  XY Plot of Pressure

Notice the effect of the shock wave on the upper surface in Figure 5.13: XY Plot of Pressure (p. 252).

4. Plot the  component of wall shear stress on the airfoil surface (Figure 5.14: XY Plot of x Wall Shear
Stress (p. 253)).

a. Disable Node Values.

b. Select Wall Fluxes... and X-Wall Shear Stress from the Y Axis Function drop-down lists.

c. Click Plot and close the Solution XY Plot dialog box.

As shown in Figure 5.14: XY Plot of x Wall Shear Stress (p. 253), the large, adverse pressure gradient induced
by the shock causes the boundary layer to separate. The point of separation is where the wall shear stress
vanishes. Flow reversal is indicated here by negative values of the x component of the wall shear stress.
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Figure 5.14:  XY Plot of x Wall Shear Stress

5. Display filled contours of the  component of velocity (Figure 5.15: Contour Plot of x Component of Ve-
locity (p. 254)).

Graphics and Animations → Contours → Set Up...

a. Ensure Filled is enabled in the Options group box.

b. Select Velocity... and X Velocity from the Contours of drop-down lists.

Scroll up in the Contours of drop-down list to find X Velocity.

c. Click Display and close the Contours dialog box.

Note the flow reversal downstream of the shock in Figure 5.15: Contour Plot of x Component of Velo-
city (p. 254).
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Figure 5.15:  Contour Plot of x Component of Velocity

6. Plot velocity vectors (Figure 5.16: Plot of Velocity Vectors Downstream of the Shock (p. 255)).

Graphics and Animations → Vectors → Set Up...

a. Enter 15 for Scale.

b. Click Display and close the Vectors dialog box.

c. Zoom in on the flow above the upper surface at a point downstream of the shock, as shown in Fig-
ure 5.16: Plot of Velocity Vectors Downstream of the Shock (p. 255).
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Figure 5.16:  Plot of Velocity Vectors Downstream of the Shock

Flow reversal is clearly visible in Figure 5.16: Plot of Velocity Vectors Downstream of the Shock (p. 255).

5.5. Summary

This tutorial demonstrated how to set up and solve an external aerodynamics problem using the pressure-
based coupled solver with pseudo transient under-relaxation and the Spalart-Allmaras turbulence
model. It showed how to monitor convergence using force and surface monitors, and demonstrated
the use of several postprocessing tools to examine the flow phenomena associated with a shock wave.

5.6. Further Improvements

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more
accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh.
Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demon-
strated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123).
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